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SpiTran Heuristic Evaluation

Author: Erika Darling

Date: August 3, 1999
Purpose

The purpose of this document is to provide usability feedback for the SpiTran translator program. 

Background

Usability Engineering was asked to review the current Java version of the SpiTran program.

Assumptions

No use model or task analysis was done. A heuristic evaluation of the user interface forms was performed.

Recommendations

General Comments

It is not clear what steps are required prior to translating the SPICE model. One suggested approach is a re-entrant wizard that shows the required steps in a window on the left pane of the main window. The user can move to any step that is enabled. The steps should have feedback using color or icons that indicate whether the step is completed. See Microsoft Publisher 98 (or later) for an example of a re-entrant wizard.

Main Application Window
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Disable the Instantiate button until there are instantiated subcircuits added. Disable the Configure Nets… button until there are instantiated subcircuits added.

There should not be a space between the ellipsis character and the word Nets in the Configure Nets button label.

Remove toolbar icons if they do not represent actual commands (there are no corresponding New, Open, or Save commands in the File menu). 

Add tooltips to the toolbar buttons.
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Menus

Provide access keys for frequently used commands in the menus (for example, New, Open, and Save). 

Provide shortcut keys for frequently used commands in the menus (for example, Ctrl+O for Open).  Align the shortcut keys in the drop-down menus to the right of the corresponding commands.

File Menu

Include the Open, Close, Save, and Save As options. If all of these are not possible, at least include options in the menu for Open and Save because there are toolbar buttons for these. Include separator bars between the groups in the drop-down menus. For example, New, Open, and Close is one group, Save and Save As is another group, and lastly place a separator bar above Exit.

Edit Menu

Move Setup to the Tools menu.

View Menu

If there are no items to place under the View menu, then do not include it.

Translate Menu

If Execute is an immediate action command then it should not have an ellipsis.

Tools Menu

Add the Setup… command here (remove from Edit)

Help Menu

The help menu should be next to the other menu headings (not right justified). 

Add an About SpiTran menu item.

New Project Workspace
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Make the Name filed have focus when the form is displayed. Create or Cancel should be the default button rather than Browse.

Implement the Help command in the dialog box.
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Browse

Reduce the height of the File name entry field so that it fits only one line of text. Also, decrease the height of the push buttons. In essence, the two entry fields should be in alignment with the descriptions (File name and Files of type) and the push buttons.
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Project Setup

If Buffer Technology is not related to Import Spice File… then they should be on separate lines. The main group box is labeled Models and a smaller grouping within that is also named Models. One of these should be changed (Make the main one more descriptive or remove it).
Add Model and Del Model should be disabled until there are items to add and delete. Also, these two push buttons are labeled confusingly.  Is the user adding items from the left box into the right box?  If so, then the following push buttons should be utilized:
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If not, then where are these models being added from?  If they are not related to the left box at all, then place the push buttons to the right of the Models box instead of between the two.

Move Ok and Cancel to the right next to the Help button.
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Browse


As recommended above, shrink the heights of the File name entry field and the push buttons.  Change Import SPICE to OK because selecting that button does not result in the file being imported.
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SPICE File Audit
Switch Reparse and Cancel so that Reparse is next to Edit SPICE and Cancel is beside Continue.

Available Subcircuits
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Configure Nets… should be disabled until subcircuits are instantiated.  
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Instantiated Subcircuits

The format of this window is awkward. As the main window it is not clear what steps should be taken.  

Include directions stating that the user should change the names of the nodes in order to make connections because this might not be clear to the novice user.

Node/Net Configuration
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The categories across the top only need to be addressed if the pin type is Float, but the table does not clearly indicate this.  To correct this, disable the columns R, Typ. Voltage, Min. Voltage, and Max.Voltage until a pin type is set to Float.  At that point, the row should change from being grayed out to an active state.  Use Title case for the column labels (Min. Voltage).

The Pin Type column contains drop-down combination boxes.  Instead of these cells appearing blank until they are clicked in, the cells should each contain a default pin type with the down arrow next to it.

The push buttons at the bottom should be shifted to the right.
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Translation Command Settings
Tree controls and property pages should completely fill their respective window locations -- Eliminate white borders from these areas. 

The window opens to the second item in the tree.  The default when opening the window should be the first item in the tree.  If it more logical for the user to view the Mode form before the Nodes form, then make Mode the first item in the tree.

if the user selects the OK button before all of the necessary fields have been filled out, supply a message dialog stating, “Not all of the forms have been completely filled out.”  Currently, when the user pressed OK without filling out the fields, they are returned to the main window without any feedback.  The user may think they have done everything correctly up to that point.

Nodes
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Omit this form because it is a repeat of a previous step.  It seems as though this information was already obtained in the Node/Net Configuration window.  

If this window is necessary than there are several changes that need to be made to it.  One change is that the drop-down combination boxes need items added to them because they currently don’t contain options.  

Also, the form contains a lot of empty space. Consider combining some of the less populated forms if they make sense organizationally. Separate the different topics with group boxes.

In addition, some of the items that are typed in appear bolded.  There seems to be no explanation for this.  Either explain why items are being bolded or eliminate the bold face completely.

One last concern involves the Import form:
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Import

Replace Import with OK because once the user clicks Import on this form, they are then brought to the Mode form where they must click Import again for the file to be imported.  Also, shrink the height of the entry field and push buttons.
Mode
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Change the SPICE Type from an entry field to a drop-down combination box because there’s a limited number of options that could be entered.  

The Cleanup line should not be a lighter shade of gray because it seems as though it’s of greater importance than the other two items.  Omit the white border surrounding the form.


Operating Range
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Voltage

The Voltage Range and Reference Values should be two radio buttons.   When 


one is selected, the entry fields of the other should be disabled.  This would


make it clearer to the user that only one set of information needs to be filled out.
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Temperature

This form should be combined with the Voltage form to reduce the amount of empty space.  

Background of property page should be gray.
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Stimulus

Display to the right of each of the entry fields that involve time (for ex. Rise Time) “ns” so that the user is aware of what units to type their times in.

Combine this form with another to reduce the amount of empty space.  Also, omit the white border, and do not use two different shades of gray in the form.
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Model Information

Many of the entry fields are not applicable under certain circumstances, and several of them should be kept empty.  However, there is no indication of this.   Entry fields that do not need to be filled out should be disabled.

Include the unit “pf” to the right of each of the entry fields for the Ccomp line. 

Omit the white boxes on the right-hand side of the form. 

Fixture
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Buffer Delay

Combine this form with another to reduce the amount of empty space.

Add a sentence explaining the purpose of this form.  An example is, “Set Vmeas and test fixture values.”

[image: image26.png][ Translation Command Settings
Butertps 0~ RisngWeveornt

Betiings For Typical Minimum Madmum
[roperam Ty Vi
* Valtage
# Temperature @ L c
® Stimulus Fiture
' Model Information out
{22 Finture

"o Butier Delay Falling Waveform 4 ———————————————————————

Typical Minimum Madmum
VT2 Vi
® Ramp Load R L c

» PastPracessing Fidure

Import Seffings from File: Ut

Import

oK. cancel | Help




VT-1

Disable any entry fields that do not apply.  Make it clear to the user if they have the option of filling out one group of entry fields or another by stating it on the form, and if possible, by separating the two groups and including radio buttons.

Move the column labels so they are over the appropriate fields rather than between fields.

VT-2
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See VT-1 for comments.

Ramp Load
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Remove this form and place the Rload entry field on a previous form because there is too much empty space.  

Add an explanation with the Rload to clarify what should be entered.  An example is, “Set load resistance for ramp time simulation.”

Post Processing
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Combine this form with another one to reduce the amount of empty space.   

Add a sentence explaining the form.  For example, “Set derating values for optional curve post-processing.”

Do not use two different shades of gray.


If there are standard values for the percentages, then set defaults.

Execution Messages
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Present a message dialog when OK is selected on the Translation Command Settings form.  If all of the necessary information has been filled out, state that all of the necessary options have been set and to proceed to the Execute command under the Translate menu.  If some of the necessary information was left blank, tell the user that there is missing information and to return to the Translation Command Settings form.

Once Execute is selected from the Translate menu and the execution is complete, add a message dialog stating that the translation was completed successfully.  Currently, the user does not receive any feedback. Switch from transcript messages to a progress bar. Give the option to view messages or expand the form to see the transcript.

